
Welcome to PhotoStudio Trial Version for Windows.
Please read the following important messages from  ArcSoft before you start the 
program:

1.    About PhotoStudio Trial Version
2.    System Configuration
3.    How to Install the Software
4.    How to Purchase the Software
5.    Setting the Display Mode
6.    Setting the Virtual Memory
7.    Using the Context Sensitive On-line Help System
8.    Digital Camera and Scanner Support
9.    Tips When Using PhotoStudio 
10.   Copyright of Sample Image Files
11.   End User Licensing Agreement

For your convenience, print this file and keep the pages handy.

You may press the F1 key to get on-line help on how to use PhotoStudio while the 
program is running. For more details, refer Section 7.

1.    About PhotoStudio Trial Version
===========================

This is a trial version only! Although it contains all the features of the release version, it 
will expire in 30 days or after 100 uses -- whichever comes first. If you enjoy using 
PhotoStudio, you may call us to register your software. Upon payment, you will be issued
a password that will release the time expiration, allowing you to use PhotoStudio 
indefinitely. Depending on your level of purchase, we will also then mail you a manual, 
original program disks and offer technical support.

Note that while we encourage you to distribute this special time-limited version to others 
who are interested, you may not distribute the registered version. Please read the license 
agreement for more details.

2.    System Configuration
===================

PhotoStudio requires the following minimum system configuration:

386-based PC or better
MS Windows 3.1x, Windows NT, or Windows 95 
4MB of RAM
4MB free hard disk space



VGA display adapter and compatible color monitor
Mouse or other pointing device

To achieve better performance, ArcSoft recommends the following system configuration:
486- or Pentium-based PC
8 (or more) MB of RAM
16- or 24-bit super VGA display adapter

3.    How to Install the Software
=======================

 1)  Insert a newly formatted 1.44 MB disk into Drive A.
 2)  Type RUNME at the DOS prompt to unzip the files to your floppy disk or hard disk. 

For this to work, you MUST have PKUNZIP in your PATH statement.
 3)  Start Windows 3.1x or exit your DOS shell in Windows 95.
 4)  In program manager run A:\SETUP (or specify the correct path) then follow the setup

instructions.
 5)  After the setup is finished, delete PHOTOSTD.ZIP and PSTUDIO.ZIP to save your 

hard disk space.

4.    How to Purchase the Software
=========================

If you are in the USA or CANADA, call ArcSoft at 1-800-762-8657 or 510-440-9901. 
Before 4/1/97, you may register PhotoStudio 2.0 for Windows for just $69.95. This gets 
you a password that unlocks PhotoStudio for unlimited use.

To receive the full PhotoStudio 2.0 package, including the manual, package, and free 
technical support, the price is just $99.95. Shipping and handling charges (and sales tax 
for California) will also apply.

Please have your PhotoStudio serial number and your credit card ready when you call.

By clicking on the "Register/Order" menu in PhotoStudio, or double clicking on the icon 
in the PhotoStudio program group, you can print out the registration and order form. You 
can either fax the form to ArcSoft at 510-440-1270, or mail it to:

ArcSoft, Inc.
Customer Service Dept.
4015 Clipper Court
Fremont, CA 94538

5.  Setting the Display Mode
=====================



We recommend using a 24-bit (over 16 million colors) super VGA display mode. If this 
mode is not available, try the mode with the most display colors. To check or change your
current Windows display setting, select the Windows Setup from the Windows' Program 
Manager. (In Windows 95, look under “Display” in the Control Panel.) Some video board
manufactures provide utilities for setting display modes. To use them, refer to the 
manufacturer's documentation.

PhotoStudio has been tested on most video cards on the market; in case you experience 
unusual screen redrawing, scrolling, and other display problems, you usually can correct 
the problems by changing your current display mode. If the problems still exist, try 
changing the display mode to the Windows standard VGA mode. If the display problems 
no longer exist when you change to the Windows standard VGA driver, it is likely that 
your video board drivers are at fault and you should contact your video card manufacturer
about their new video driver releases that may correct the problems. 

6.  Setting the Virtual Memory
=======================

The more RAM that is available to PhotoStudio, the larger the image you can 
successfully manipulate, and the better performance you can obtain.

It is very essential to set the virtual memory in your system to certain amount (depending 
on the size of the RAM and available hard disk space). Follow the instructions below to 
set the virtual memory if you are running Windows 3.1x:

1. Go to the Main group and double click on the Control Panel icon.
2. Double click on the 386 Enhance icon.
3. In the 386 Enhanced dialog box, click on the Virtual Memory button.
4. In the Virtual Memory dialog box, click on the Change button to expand the dialog 

box.
5. Go to the Drive list box and select the drive which has the most available space in your

system.
6. Go to the Type list box and select Permanent.
7. Go to the New Size editing box and enter the same value as shown in Recommended 

Maximum Size.
8. Click OK to activate your setting and close the dialog box.

Use the default memory settings if you are running Windows 95 or Windows NT.

7.  Using the Context-Sensitive On-line help System
======================================

PhotoStudio has an intuitive user interface. In addition, it provides you with context-



sensitive help that can be invoked at any time by pressing the F1 key.

To use the help system in the standard Windows manner, simply choose your topic from 
the Help menu at the right side of the menu bar. A help window containing PhotoStudio’s 
help information on that general topic will appear, and you can proceed from this help 
page to the specific topic you want by clicking on the subtopics that interest you. 
Clicking on the Search button will call up a list of general PhotoStudio terms and topics.

To use the context-sensitive help, get to the dialog box or menu item you are curious 
about and then press the F1 key. For example, if you want to see the help on the Stitch 
menu command, pull down the Edit menu, highlight the Stitch command without 
releasing the mouse button, and press F1 (while still holding the mouse button down). 
The help window will appear, with the information on the Stitch command already 
displayed! This helps you to get directly to the topic you want without having to search 
through the help topics and subtopics.

When you have a dialog box open, simply press F1 to get help on the related topics.

8.  Digital Camera and Scanner Support
==============================
PhotoStudio supports all digital cameras and scanners that are 100% compatible with 
TWAIN interface standard for image acquisition. For information on setting up your 
digital camera or scanner to work with PhotoStudio, refer to the camera or scanner 
documentation and the user's manual. If your hardware manufacturer did not provide you 
with a TWAIN driver, contact the digital camera (or scanner) manufacturer directly. If 
your input device support multiple image acquiring and you like to turn on this feature, 
you may add an entry MultiScan=1 in PSTUDIO.INI located in Windows directory . If 
your scanner only support memory scan mode, you should add an entry MemoryScan=1 
in PSTUDIO.INI.

9.  Tips When Using PhotoStudio
========================

Keep your computer’s memory uncluttered.  To free up memory, close the images 
you are not working with. Close any windows that you do not need. Having a window 
open will take up memory.  This will decrease the amount of  available memory that 
PhotoStudio has available to perform tasks on your active window.

Clear the Clipboard image or replace it with a smaller one if you will not use it any more.
Images kept on the Clipboard will also take up space and slow down PhotoStudio.

If you are only working on a small part of the picture, make sure that area is 
selected.  Not only will you speed up PhotoStudio, you will also protect the parts of the 
picture that you do not want to change.



Even if you are working with the entire image, try editing a small part of the image first.  
Once you are sure of the edits you want to make, you can go back and modify the entire 
image.  This is an especially helpful technique when you are applying complex effects or 
filters which take a long time for PhotoStudio to perform.

If a process does not work, there may be a small select area. Even if you can not see a 
marquee, there may be a select area that is too small to see, or it may be in part of your 
image that is not currently on screen.

To eliminate the possibility that there may be a select area, click on the image screen with
the Select tool, or press Delete key.  After you do this, the process should begin to work 
on the entire image correctly.

If a command does not seem to be available, the image may be required to be in 
either 24-bit color or 8-bit grayscale data type. For example, the Blur and Sharpen 
functions, and the functions in the Effects menu work only with 24-bit color and 8-bit 
grayscale images. You can check your image data type from either the “Image 
Information” command or read from the Status Line ( at the bottom of the program 
windows). To convert an image data type from one to another, use the Convert 
commands.

10.  Copyright of Sample Image Files
===========================

The sample image files you installed on ..\SAMPLES and ..\PATTERNS sub-directories 
are copyrighted by ArcSoft, Inc. You may use them for testing the software, or designing 
art-work. However, as a portion of the PhotoStudio program, multiple duplication or 
redistribution of these images are not permitted. ArcSoft, Inc. reserves all rights.

11.  End User License Agreement
=========================

The following is a legal software license agreement between you, the software end user, 
and ArcSoft, Inc.  Carefully read this license agreement before using the product. 
Using the product indicates that you have read this license agreement and agree to its 
terms.

Grant of License. This license permits you to use one copy of the software included in 
this package on any single computer.  For each software licensee, the program can be “in 
use” on only one computer at any given time. The software is “in use” when it is either 
loaded into RAM or installed into the hard disk or other permanent memory. A special 
license permit from ArcSoft is required if the program is going to be installed on a 
network server for the sole purpose of distribution to other computers.



Copyright. The software contained in this package is owned by ArcSoft and is protected 
by United States copyright laws, international treaty provisions, and all other applicable 
national laws. The software must be treated like all other copyrighted materials (e.g. 
books and musical recordings). This license does not allow the software to be rented or 
leased, and the written materials accompanying the software (if any) may not be copied.

Limited Warranty. ArcSoft, Inc., warrants that the software contained herein will 
perform substantially in accordance with the accompanying documentation.

No Other Warranties.  ArcSoft disclaims all other warranties, either express or implied, 
including but not limited to implied warranties of merchantability and fitness for a 
particular purpose, with respect to the Software, the accompanying written materials, and 
any accompanying hardware (if any).

No Liability for Consequential Damages.  In no event shall ArcSoft or its suppliers be 
liable for any damages whatsoever (including but not limited to damages for loss of 
business profits, business interruption, loss of business information, or any other 
pecuniary loss) which results from an inability to use this software, even if ArcSoft, Inc. 
has been advised of the possibility of such damages.  Because some states/jurisdictions 
do not allow the exclusion or limitation of consequential or incidental damages, the above
limitations may not apply to you.

U.S. Government Restricted Rights. The Software and documentation are provided 
with Restricted Rights.  Use, duplication, or disclosure by the U.S. Government is subject
to restrictions as set forth in subparagraph ©(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013 or subparagraphs ©(1),(2), and (3) of
the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as 
applicable, and any amendments thereto.  The manufacturer is ArcSoft, Inc., 4015 Clipper
Court, Fremont, CA 94538.

If this product was purchased in the United States, this Agreement is governed by the 
laws of the state of California; otherwise, local laws may apply.

ArcSoft, Inc. All rights reserved.


